ENVIROMUX® Series

E-MNG-LC
Environment Monitoring System Management Software
# Table of Contents

**Introduction** ......................................................................................................................................................................................... 1  
**Materials** ..................................................................................................................................................................................... 3  
**Limitations** .................................................................................................................................................................................. 3  
**Installation** .................................................................................................................................................................................. 4  
  - Licensing .................................................................................................................................................................................. 4  
  - Get Machine ID ......................................................................................................................................................................... 5  
  - Install Permanent License .......................................................................................................................................................... 6  
  - From the Command Line ........................................................................................................................................................... 7  
  - Start the Server, Configuration is Done......................................................................................................................................... 7  
**Server Management** .......................................................................................................................................................................... 8  
  - Manage From the GUI (Graphical User Interface) ......................................................................................................................... 8  
  - Add UNITS to Monitor ................................................................................................................................................................. 8  
  - Device Discovery Tool ................................................................................................................................................................. 9  
  - Add E-MNG-LC Users .............................................................................................................................................................. 10  
  - Edit E-MNG-LC Users .............................................................................................................................................................. 10  
  - UNIT Loses Connection ........................................................................................................................................................ 11  
  - Manage From the Command Line ............................................................................................................................................... 12  
**Using a Client** .................................................................................................................................................................................... 13  
  - User Connection ........................................................................................................................................................................ 13  
  - Project Management .................................................................................................................................................................. 14  
    - Create a Project ....................................................................................................................................................................... 14  
    - Open a Project ........................................................................................................................................................................ 17  
    - Delete a Project ....................................................................................................................................................................... 19  
  - Remote UNIT Management ...................................................................................................................................................... 20  
    - View Summary ........................................................................................................................................................................ 20  
    - View Scrolling Summary ....................................................................................................................................................... 22  
    - Configuration Options .......................................................................................................................................................... 23  
    - User Configuration ............................................................................................................................................................... 24  
  - Sensor Monitoring and Configuration ........................................................................................................................................... 25  
  - Respond to Alerts ...................................................................................................................................................................... 29  
**Server Management from the Client** .................................................................................................................................................. 31  
**E-MNG-LC Log Files** ........................................................................................................................................................................ 32  
  - Server Logs ................................................................................................................................................................................ 32  
  - Client Logs ................................................................................................................................................................................ 33  
**Software Update** ................................................................................................................................................................................ 36  
**Setup E-MNG-LC to Run At Startup** .................................................................................................................................................. 36  
**Restore Root Password to Default** .................................................................................................................................................. 37  
**Index** .............................................................................................................................................................................................. 37  

# Table of Figures

Figure 1- End User License Agreement ........................................................................................................................................... 4  
Figure 2- License Installation screen .............................................................................................................................................. 5  
Figure 3- Server software-Install License tab .................................................................................................................................. 5  
Figure 4- License Activation screen ................................................................................................................................................ 5  
Figure 5- Registration and License Request Form ........................................................................................................................ 6  
Figure 6- Login to server .................................................................................................................................................................. 8  
Figure 7- Add UNITS to monitor .................................................................................................................................................... 8  
Figure 8- Device Discovery Tool page ........................................................................................................................................... 9  
Figure 9- Create new user ............................................................................................................................................................. 10  
Figure 10- Edit User ....................................................................................................................................................................... 10  
Figure 11- UNIT has lost connection to network ........................................................................................................................ 11  
Figure 12- Reload UNIT to restore sensing and management .................................................................................................. 11  
Figure 13- Login at a Client ........................................................................................................................................................... 13  
Figure 14- Empty list- no Projects defined yet .................................................................................................................................. 13  
Figure 15- File Menu choices ........................................................................................................................................................ 14  


INTRODUCTION

The E-MNG-LC is intuitive graphical software that provides an easy-to-use, unified interface for both monitoring and configuring up to 3,000 E-MICRO-T(RHP) Micro Environment Monitoring Systems and E-1W(P) Environment Monitoring Systems with 1-Wire Sensor Interface (UNITS) and all connected sensors. The software is split into two parts, the Server (to actively poll all UNITS for status information and alerts) and Client (to communicate with the Server from any location to read statuses and make configuration changes).

A License Activation Key is required to use the software after the 30 day trial period. A License Activation Key supporting up 3000 UNITS is available from [http://www.networktechinc.com/enviro-manage-software.html](http://www.networktechinc.com/enviro-manage-software.html)

Features:

- Units may be monitored and configured individually or in a group.
- Display values and status for individual sensors or list of sensors.
- NTI will provide customer, without charge, copies of any appropriate updates/enhancements for 12 months. This software update service is optionally extendable every twelve months for 20% of the then current list price.
- Client/Server architecture
  - Server application actively polls all UNITS for status information as well as listens for alerts from all UNITS.
  - Client application communicates with the Server to read statuses and to deploy configuration changes.

Server and Client Requirements:

- Requires Java Runtime Environment 1.7 or later.
  - To use E-MICRO-T(RHP) units with software version 3.0 and later, Java Runtime Environment version 1.8 or later is required.
- Requires firmware version 2.1 or later in E-MICRO-T(RHP) and E-1W(P) units.

Hardware Requirements:

Below minimum requirements assume CPU with physical cores (rather than virtual) and an OS similar to MS Windows or Linux with minimal usage from other user applications.

Server Configuration:

1 - 50 UNITS, 1- 5 clients:
Minimum requirements: Dual core CPU with 2 GB RAM 100 Mbps network
Recommended Configuration: Quad core CPU with 4 GB RAM 100 Mbps network

50 - 100 UNITS, 5 - 15 clients:
Minimum requirements: Quad core CPU, with 4 GB RAM 100 Mbps network
Recommended Configuration: 8 core CPU with 8GB RAM 100 Mbps network
100 - 600 UNITS, 10 - 25 clients:
Minimum requirements: 8 core CPU with 8GB RAM 100 Mbps network
Recommended Configuration: 12 core
CPU with 16 GB RAM 1 Gbps network

600 - 1400 UNITS, 15 - 35 clients:
Minimum requirements: 12 core CPU with 16 GB RAM 1 Gbps network
Recommended Configuration: 20 core
CPU with 24 GB RAM 1 Gbps network

Client Configuration:
1 - 40 UNITS:
Minimum requirements: Dual core CPU with 2 GB RAM 100 Mbps network
Recommended Configuration: Quad core CPU with 4 GB RAM 100 Mbps network

40 - 100 UNITS:
Minimum requirements: Dual core CPU with 2 GB RAM 100 Mbps network
Recommended Configuration: Quad core CPU with 8 GB RAM 100 Mbps network

100 - 300 UNITS:
Minimum requirements: Quad core
CPU with 8 GB RAM 100 Mbps network
Recommended Configuration: 8 core
CPU with 16 GB RAM 1 Gbps network

600 - 1400 UNITS:
Minimum requirements: 8 core CPU with 16 GB RAM 1 Gbps network
Recommended Configuration: 10 core
CPU with 20 GB RAM 1 Gbps network

If installing over 1400 UNITS to manage from a single machine, contact NTI for custom setup.
MATERIALS

Materials supplied with this package:
NTI E-MNG-LC ENVIROMUX Management Software including:

- mng-lc-srvr-vx-x.zip file (for the management server) (vx-x = the version number)
- mng-lc-clnt-vx-x.zip file (for client PCs) (vx-x = the version number)
- Adobe pdf file of this manual

LIMITATIONS

- The Management Software:
  - cannot view logs
  - cannot simulate alerts
  - cannot change IP addresses of the UNITS
  - cannot save or restore individual UNIT configurations from within the management software

- The Server application is licensed to be applied to one CPU and will only work on the CPU with the Machine ID (MAC address) supplied at the time of license issue. To move the Server application to a different CPU, contact NTI to request an updated license.

- There is no limit to the number of Client applications that can be installed on CPUs to access the Server and connected UNITS.

- There is no limit to the number of Clients that can access the Server at a time

- Multiple Server applications can monitor UNITS at the same time with no ill effects.

- There is no limit in the program to the number of users that can be configured to use the Client to access the Server. The number of users configured will only be limited by the amount of memory in the server hosting the program.
**INSTALLATION**

The E-MNG-LC enables an administrator to manage multiple UNITS (up to 3,000) either from a central CPU acting as a server or from client CPUs. In order for a client CPU to manage UNITS, the client must have access to this server.

To install the **Server software on a computer**, unzip the mng-lc-srvr-vx-x.zip file received via email to a directory where the software will run. (vx-x will be the version number of the software.)

**TIP:** At this time, you might want to place a shortcut on the desktop to run the emicromanagersrvr.jar file. (In Windows, right-click the .jar file, click “Send To”, click “Desktop (create shortcut)”.

**Note:** Ensure that the server firewall allows TCP ports 9000, and 9001 access. If a UNIT is behind a firewall, ensure UDP port 161 and 162 (SNMP) and TCP port 6000 is accessible.

**Note:** SNMP must be enabled in each ENVIROMUX Unit monitored for the E-MNG to receive and display sensor values.

The E-MNG-LC also enables any PC (with Java installed and with access to the Server) to additionally manage the ENVIROMUX units. The PC (Windows/Sun/Mac/Linux/etc) can access the Server via an Ethernet connection. These PCs will be referred to as “clients” throughout this manual.

To install the **Client software on a computer**, unzip the mng-lc-clnt-vx-x.zip file received via email to a directory where the software will run. (vx-x will be the version number of the software.)

**TIP:** At this time, you might want to send a shortcut to the desktop to run the emicromanager.jar file. (In Windows, right-click the .jar file, click “Send To”, click “Desktop (create shortcut)”.

Be sure that Java Runtime Environment 1.7 or later is installed on the server and each client. This software can be downloaded from http://java.com/en/download/manual.jsp. (JRE 1.8 or later is needed if your E-MICRO units have firmware version 3.0 or later installed).

**Licensing**

After installing the server software and Java Runtime Environment (version 1.7 or later), the Server software can be opened by double-clicking on the EmicroManagerSrvr.jar file in the directory mng-lc-srivr-vx-x.zip was unzipped to. When you start the EmicroManagerSrvr.jar file the first time the End User License Agreement will be presented.

![End User License Agreement](Figure 1- End User License Agreement)

After reading the agreement, make sure “I agree with the above terms and conditions” has been selected and click on **Next**.

You will then be presented with a license installation screen.
If you have not yet purchased the E-MNG-LC and are evaluating it, a temporary license to use it in conjunction with up to 10 ENVIROMUX units for 30 days can be automatically generated. After 30 days, the software will not work unless a valid permanent license is installed, or another temporary license can be generated, but all configuration settings will be lost. Only the purchase and installation of a permanent license will avoid losing your configuration.

For now, click on “Generate 30 days license” to access the E-MNG-LC menu.  

**Note:** See “Deactivate User Account Control” on page 6 before generating a temporary or activating a permanent license.

To install a permanent license, you must have purchased the software and submitted for a license activation key. Upon purchasing the software, you will receive a confirmation email that includes a product serial number for the software purchase. That number, combined with the Machine ID of the computer the Server software is on, will be required to apply for the License Activation Key.

**Note:** It can take up to 3 business days after submitting your License Request Form to receive your License Activation Key.

### Get Machine ID

With the Server software main menu now open, select “Help” and “Install License”.

![Figure 3- Server software-Install License tab](image)

The following image will open:

![Figure 4- License Activation screen](image)

The “Machine ID” of the computer is in the first line of the image (example above). Write this down exactly as shown and enter it on the Registration and License Request Form found at [http://www.networktechinc.com/license-request-env.html](http://www.networktechinc.com/license-request-env.html).
**Install Permanent License**

Within 3 business days, you will receive an email that includes a License Activation Key. Enter the key with the characters exactly as they are in the body of the email in the block provided in the “Activate License” screen (Figure 4).

With a proper entry of the License Activation Key, click on **Activate**. The E-MNG-LC software should now be ready to use.

**NOTE:** The Server application is licensed to be applied to one CPU and will only work on the CPU with the Machine ID supplied at the time of license issue. To move the Server application to a different CPU, contact NTI to request an updated license.
From the Command Line

If the Server software is unzipped to a CPU that operates strictly from the command line, then the following commands will provide access to the Server in that environment:

From the directory the Server software has been extracted to type:

C:\E-MNG-LC> java -jar EmicroManagerSrvr.jar root nti -config

You will be prompted to accept the terms and conditions, type Y and press <Enter>:

Do you agree with above terms and conditions? (y or n): y

A valid license key was not found on your system!

Select an option:
  Generate 30 days license <1>
  Install permanent license <2>
  Cancel <3>
> 1

The software will check for a license key.
- If you already have one, enter <2> to be prompted to enter it and simply copy and paste the key from the email message it was received on, or carefully type the key in.
- If you don’t have a license key, enter <1> to generate a temporary 30 day license.

Note: The terms and conditions will only be displayed until a temporary license is generated or a permanent license is installed. After that, only the license status and command prompt (below) will follow the initial command to open the program.

Once the license is entered, the command prompt will be ready to receive control commands to configure the server. To see a list of commands the server will accept, type <help>.

C:\E-MNG-LC> java -jar EmicroManagerSrvr.jar root nti -config
Nb of allowed Enviromux units: 10
Expires on: Sat Dec 29 16:57:10 EST 2012
Type 'help' to view available commands
>

For more on server management from the command line and a list of commands, see page 12.

Start the Server, Configuration is Done

To start the ENVIRMUX-MNG-LC server without going into the configuration mode, type the following at the command prompt:

C:\E-MNG-LC> java -jar EmicroManagerSrvr.jar root nti -nogui

Note: If you have changed the root user password, substitute the new password for “nti” in the string above.

To stop the server, terminate the program using a command appropriate for your operating system (<Ctrl+c> for DOS, <kill> for Linux, etc).
Manage From the GUI (Graphical User Interface)

Immediately after installing the license, and any time hereafter that you double-click on the `emicromanagersrvr.jar` file, the server management software will open to the login screen. The administrator is named "root", and the root user will be prompted for a password.

The default password is “nti”.

Only the “root” user can access the “Server” side of the management software.

*Note: If the root user password has been changed and this installation is an update (rather than a new installation), the previous root password will not be changed with the updated software installation.*

To reset a forgotten password back to "nti", see page 37

Figure 6- Login to server

The software will open to an empty list that will contain all connected UNITS to be monitored by the E-MNG-LC. UNITS are easily added using IP address, or DNS name (if so configured).

*Note: The server will offer to update the root password of any UNIT that has a root password other than “nti”. Otherwise, these units will require a separate login when the server software is started.*

Add UNITs to Monitor

To add a UNIT, click on the “File” menu and select “Add Unit”. A window will open as shown below.

Enter the IP address for the UNIT or the DNS name (if applicable) and press “Add”. If the IP address is valid, the UNIT will appear in the server list. If not, the message “cannot find unit” will be displayed below the “Add” and “Done” buttons. When finished adding UNITS, click the “Done” button to close the window.

*TIP: If you don’t know the IP addresses of the UNITS to be monitored, you can use the included NTI Discovery Tool (page 9) to identify them (provided they are all connected to the same LAN).*

Figure 7- Add UNITs to monitor
Device Discovery Tool

In order to easily locate the UNIT on a network, the NTI Device Discovery Tool may be used. The Discovery Tool is available on many of our webpages, including http://www.networktechinc.com/download/d-environment-monitor-micro.html. Download the discovery.zip, extract the contents to your PC and click on the file NTIdiscover.jar. This will open your browser and display the Device Discovery Tool page.

**Note:** The Device Discovery Tool requires the Java Runtime Environment to operate.

**Note:** The computer using the Device Discovery Tool and the ENVIROMUX must be connected to the same physical network in order for the Device Discovery Tool to work.

---

**Network Technologies Inc**

**Device Discovery Tool**

- **START**
  - When you load this page, the NTI Device Discovery Applet should load. Accept the Certificate to allow this applet access to your network. Press the button entitled **Detect NTI Devices** to start the discovery process. After a short time, the tool will display all NTI devices on your network, along with their network settings.

  **Note:** Do not close this page while the NTI Discovery Tool is running. Close the NTI Device Discovery Application first, then this webpage.

- **How To Use the Discovery Tool**
  - **To Change A Device's Settings**, within the row of the device whose setting you wish to change, type in a new setting and press the **Enter** key or the **Submit** button on that row. You can also press the **Submit All** button to submit all changes at once.
  - **To Refresh the list of devices**, press the **Refresh** button.
  - **To Blink the LEDs of the unit**, press the **Blink LED** button (This feature not supported on all products). The Blink LED button will change to a **Blinking...** button. The LEDs of the unit will blink until the **Blinking...** button is pressed, or the NTI Device Discovery Application is closed. The LEDs will automatically cease blinking after 2 hours.
  - **To Stop the LEDs of the unit blinking**, press the **Blinking...** button. The **Blinking...** button will change to a **Blink LED** button.

  ![Figure 8- Device Discovery Tool page](image)

Use the Device Discovery Tool to display all NTI ENVIROMUX units on the network, along with their network settings. Follow the instructions on the Device Discovery Tool page to use the tool and to change the device settings if so desired.

![NTI Device Discovery](image)
Add E-MNG-LC Users
The administrator can add Users (as many as desired) that can access the MS and manage monitored UNITs. The list of users is saved in the server but can be configured from any client location. The “root” user can add users, define passwords, and assign administrator rights to a user if so desired. Only listed users will have access to the E-MNG-LC.

Users with administrative rights are able to manage users in the individual UNITs, allowing them to add, edit, and delete users, as well as change passwords.

To add a user, click on the “Users” menu item and select “Add User”. A window (see Figure 9) will open to define a User Name and Password. Place a checkmark in the box next to “Administrative Rights” if you want this user to have control as described above.

Edit E-MNG-LC Users
The root user or users with administrative rights can make changes to a user’s password and change their status as an administrator. Simply click on the “Users” menu and select “Edit User”. A window will open where the desired user can be selected and boxes are available to change user settings or delete a user (see Figure 10).

After making changes, press “Submit Changes” to have them take effect.

After all changes are complete, press “Done” to exit the window.

To delete a user, select the User name from the list and press “Delete”.

*Note: A password must be provided, even if it is only 1 character.*
**UNIT Loses Connection**

If a UNIT loses connection to the network, whether via power failure or Ethernet, the E-MNG-LC will indicate it.

![UNIT has been disconnected](image)

**Figure 11- UNIT has lost connection to network**

With the power or Ethernet connection restored, the software can be prompted to quickly reload the UNIT and restore sensing and management. Simply right-click (with the mouse) on the client IP address and be prompted to either “Reload” the UNIT or “Delete” it from the list.

![Reload UNIT to restore sensing and management](image)

**Figure 12- Reload UNIT to restore sensing and management**
Manage From the Command Line

To control the E-MNG-LC Server from the command line, enter the following command from the directory the server files have been unzipped to:

```
C:\E-MNG-LC>java -jar EmicroManagerSrvr.jar root nti -config
```

Nb of allowed Enviromux units: 10
Expires on: Sat Dec 29 16:57:10 EST 2012
Type 'help' to view available commands

Type `<help>` to view the available commands.

```
>help
  showid             - Displays the machine ID for licensing
  license <license_string> - Install license
  del_license       - Remove current license
  passwd            - Change root password
  listunits         - Lists the Enviromux units in the project
  addunit <IPAddress> - Add an Enviromux unit with IP address
  delunit <IPAddress> - Delete an Enviromux unit with IP address
  listusers         - Lists the available users
  adduser           - Add a user account
  deluser           - Delete a user account
  run               - Exit config mode and start the server
  exit              - Exit
```

If you have not yet applied for a permanent license, you will need to get the Machine ID for the License Request Form (page 6). Enter the command `<showid>` to see the machine ID.

```
>showid
00-0C-29-8D-43-09
```

Write down the number presented for entry into the License Request Form.

Once you receive the license, enter the command `<license>` and the license string provided by NTI.

```
>license <license_string>
```

If, at some point, the E-MNG-LC Server is moved to a different CPU, the license will need to be updated to work with the new CPU. To first delete the license from the initial server, enter the command `<del_license>`.

Once the server is configured using the other commands to view, add, or remove ENVIROMUX Units to be managed and view, add, or remove users to have client access, either enter `<run>` to start the server, or `<exit>` to exit the configuration program.

To start the server without entering the configuration program, enter the following command (substitute current password for “nti” as applicable):

```
C:\E-MNG-LC>java -jar EmicroManagerSrvr.jar root nti -nogui
```

Nb of allowed Enviromux units: 10
Expires on: Sat Dec 29 16:57:10 EST 2012
Server started

To stop the server, terminate the program using a command appropriate for your operating system (<Ctrl+c> for DOS, <kill> for Linux, etc).
USING A CLIENT

With users and passwords assigned, a user can access the E-MNG-LC Management Software from any computer with the Client software loaded, provided the user has access to the computer the Server software is on. There is no limit to the number of Clients that can access the Server at a time and there is no limit to the number of users that can be configured to use the Client to access the Server.

User Connection

After installing the Client software and Java Runtime Environment (version 1.7 or later), the Client software can be opened by double-clicking on the EmicroManager.jar file (in the directory mng-lc-clnt-vx-x.zip was unzipped to). A login screen will appear. Enter the IP address of the server, a valid user name (other than root) and password and the manager screen will open.

If you enter user name “root” and the password for “root”, an administrative screen will open enabling the management of server settings. See page 31 for more about this.

Note: The client software will remember the last IP address entered, so this may not need to be repeatedly entered with each login unless the IP address of the server changes.

The Client program uses ports 9000 and 9001. As long as the server has those ports open any client can access the Server program.

The Client PC’s do not need any firewall ports open.

Figure 13- Login at a Client

The Client software will open to a blank window, wherein the user can create “Projects” that include groups of specific UNITs that are to be monitored. Each user can create unique projects used to monitor all available UNITs, or just a portion of them.

Figure 14- Empty list- no Projects defined yet
Project Management

Each user can monitor any or all connected UNITs. A project is made up of UNITs placed into a single group or can be broken up into category-specific groups for more organized monitoring. Any or all UNITs can be placed into each group. Once they are defined, the list of groups and their included UNITs can be saved as named projects for easy recall later. Multiple projects can be defined for each user. From the “File” menu, a user can create a new project, open an existing project, or delete existing projects.

Create a Project

To create a new project go to the “File menu” and select “New Project”. The word “<empty>” will be replaced by “New Project”.

![Figure 15- File Menu choices](image)

With the project “New Project” highlighted, go to “Edit” menu and select “Project Settings”. A project window will open.

FYI: The “Project Settings” selection is also used to edit an existing project.

![Figure 16- Select Project Settings](image)
From the project window, click on the “New Group” button to add a group number under “New Project”. Then click on the group name to select it. Select each UNIT from the list of “Available ENVIROMUX units” list that should be included in this group. With the UNITs selected either:

- click on “Save” to save the project, then “Cancel” to exit the project window,
- click on “New Group” to define another group of UNITs,
- or just click “Cancel” to cancel the action, save nothing, and return to the empty “New Project” window.

Click “New Group” to add a group that will include some or all of the monitored units in the list.

Figure 17- Define a new project

A unique name can be assigned to the project.

To change the Project name double-click on the Project name and type the new name. Press <Enter> to save it, or <Esc> to cancel.

Use the same procedure to change Group names.
Figure 18- Change names of project and groups

If you apply a checkmark to the “Enable pop-up alerts when sensors go to Alert Mode” box, then any sensor that calls for an alert will cause a pop-up on your computer screen and an audible indication as long as you are logged-into the client software.

With the project settings defined, and groups defined, click on “Save” to save the settings. Click “X” to close the window. Now the groups will be listed (below). Click the group names to see the UNITs selected listed below each (Figure 19).

Notice, below, that one UNIT in one group is also in the other. A UNIT can belong to as many groups as desired.
1. Select a UNIT to view the sensor category list.
2. Select a category to see the sensors in that category.
3. Select a sensor to see the status of that sensor.

Open a Project
In the image below, rather than creating a new project and re-selecting UNITs to be monitored, the user will open the “Test” project, a previously created project that contains all the UNITs the user wants to monitor.

1. Go to the “File” menu and select “Open Project”.

Figure 20- Exploded view of E-MNG-LC

Figure 21- Open existing project
2. A list of existing projects previously defined will appear. Select the one desired and click “Open”.

**Figure 22- List of existing projects**

Click “Open” to open the pre-defined “Test Project” Project

3. The selected project is now open and ready to review.

**Figure 23- Existing project open, ready for viewing**
Delete a Project

To delete a project, select “Manage Projects” (Figure 21) from the “File” menu. Select the project name to remove and click the “Delete” button. That project and any groups defined within it will be removed from the projects list.

FYI: The user can also open an existing project from the Manage Projects window, if desired.

![Figure 24- Deleting a project](image-url)
Remote UNIT Management

From the E-MNG-LC manager, the user can perform many UNIT management functions that otherwise can only be performed when connected to the individual UNIT through the web interface.

To open a menu for making configuration changes to a UNIT, right click the UNIT name in the list. From here, the following areas of a monitored UNIT can be managed:

- **View summary** - to view a summary status of all connected sensors
- **View scrolling summary** - to view a scrolling summary with a controlled window size of all or select categories of connected sensors
- **Configure Enterprise** - Field for entering the name of the E-Micro UNIT being managed
- **Configure Network** - Fields for viewing all the network settings and changing the DNS server settings if desired.
- **Configure SNMP Agent** - Apply SNMP agent settings
- **Configure Email Server** - Apply email settings for the E-Micro
- **Configure Date & Time** - Apply Date and Time settings for the E-Micro
- **Users** - Add and edit all user settings including passwords (available to users with administrative privileges only)

![Figure 25- Options with right click on UNIT](image)

**View Summary**

With the UNIT selected, right click and select “View Summary” to see a summary view of the status of all sensors connected to a UNIT.

![Figure 26- Summary view of sensors in a UNIT](image)
If desired, the Summary view for each unit can be opened for easy monitoring. They can be arranged in a “Cascade” view, like in Figure 27, or in “Tile” view, like in Figure 28. Simply select the summary view for each UNIT to be displayed, then select the view method. The view methods of “Cascade” or “Tile” are found under the “Window” menu.

**Figure 27- View multiple summary pages in Cascade View**

**Figure 28- View summary pages in Tile View**
View Scrolling Summary

The scrolling summary provides a more controlled way to limit the amount of screen space used for summary view and to view only those sensors that you want to keep on.

By applying limitations to the Filters (1-3), limit the view of the scrolled sensors to only those types of sensors you have an interest in seeing the information on. The status of each is updated dynamically based on the configured refresh rate of each sensor.

A scrolling summary can include only the sensors for a specific unit (as shown in Figure 29), or, it can include sensors from an entire group of ENVIROMUXs (shown in Figure 30).
Configuration Options

Click on “Configure Enterprise”, “Configure Email Server”, “Configure Network”, “Configure SNMP Agent” or “Configure Date and Time” to access the configuration options of the ENVIROMUX you are managing.

Figure 31- Configure Unit Settings
User Configuration

Click on “Users” to access individual user configurations within each ENVIROMUX. From there you can Add, Remove, and Edit user configurations.

Figure 32- Manage User Settings
Sensor Monitoring and Configuration

Sensor readings can be monitored, settings can be quickly configured to change the criteria for reporting alerts, or they can be removed altogether. Right-click on a sensor to bring up a menu enabling you to Monitor, Configure, Remove a sensor, Start Recording sensor readings taken and View a History Graph of those readings.

Figure 33- Manage a sensor- choose action

Select “Monitor” to see the status of the sensor.

Figure 34- Monitor status of the "Undefined" external sensor
Select "Data Recording Status" and then click "Start Recording" to have the readings for the sensor stored in memory. Once the start recording, a graph will be created from the readings taken. Readings will be stored for up to 120 days, after which old readings will drop off to make room for new readings.

To view the readings stored, select "View History Graph".

A graph that shows a sensor’s readings can be viewed. The time period displayed can be changed to show the last hour, last day, last week, last 30 days or the last 120 days.

The color of the graph can be changed. Click on “Color” to bring up a color chart. Select the desired color and press “OK”. (The color change will only take effect as long as you have the history graph open. Once closed, upon reopening the graph the original color will be displayed again.)

The range of readings displayed will adjust as the readings are taken. For example, in the above image, for the time period displayed the range of readings was between 38.2°F to 39.2°F. If expanded to view the Last Day, the range would automatically update to a wider range of temperatures and adjust the graph accordingly.

If you right-click inside the graph, a menu with more options will be presented. Click on “Properties” to bring up options to change the “Chart Properties” or appearance of the graph.

Note: The changes you make will only take effect until you close the graph. Upon reopening the graph, the appearance will again be based on default settings.
To copy the graph image to your computer’s clipboard for pasting into another document, click “Copy”.

To save the graph image as a .png image file on your computer, select “Save as…”.

To send the graph image to a printer, select “Print…”.

To see greater detail in the graph, the range and/or domain axis can be zoomed in or out. To quickly return to a normal view of the graph, click on “Auto Range-Both Axes”.

Figure 37 - You can zoom your axes

Another way to see greater detail is to select a specific area on the graph dragging from the top in a downward diagonal motion. When you let go of the mouse the graph will update with a closeup of the area you selected.

Figure 38 - Drag a selected area to zoom in on

To restore the default appearance of the graph, drag upward on the graph.
Select "Configure" (from Figure 33) to configure the settings for that sensor.

Figure 39- Configure the external sensor
Respond to Alerts

When an alert is present, the first screen in the project will indicate it by displaying the group name in red.

Click on the group name to see which UNIT is reporting an alert.

Click on the E-MICRO to see which group of sensors the individual sensor is in.

Click on the UNIT and “Alerts” to see which sensor has an alert.

A Temperature sensor is reporting the alert
Click on the sensor to monitor its status. Click on the alert to respond to the alert condition.

![This sensor is in alert](image)

**Figure 43- Alert 4- Status of the sensor in alert**

With the sensor status returned to normal, the sensor tree returns to an alert-free appearance.

![Alert has been acknowledged](image)

**Figure 44- Alert 5- Alert has been acknowledge**
Server Management from the Client

If, at the login screen, you enter the username “root” and the password for root (default is “nti”), the program will open to an administrative menu that provides options for server management. The server can be managed from the graphic interface provided by the server software, from the command line interface, or, in this case, through the client software.

Figure 45- Login as root from Client

The menu for root includes only administrative functions.

Using these functions you can configure the server for password preference, adding, editing, or removing users, adding units, or activating the license.

Figure 46- Manage Server from Client
E-MNG-LC Log Files

Log files can be generated as they pertain to the events monitored by the E-MNG-LC software. By configuring the *sems.conf* file found in the directory the Server was extracted into, log files can be generated and then viewed for use in troubleshooting, generating reports, or other programs intended to cause actions based on alert status.

Server Logs

Datalogs and alert logs on Server Software can be configured by editing "*sems.conf*" file (using a text editor such as Notepad) below.

Please note license activation is required to enable all logging features.

- `syslogEnabled=true`
- `datalogEnabled=true`
- `alertslogEnabled=true`

1. “Enabled” values can be set to “true” or “false”.

   - SEVERE will log only system crash like messages.
   - WARNING will log severe messages and messages that user needs to look into
   - INFO will log all above messages plus some rudimentary messages like “server started”
   - FINE or ALL will log all communications and may generate several GB of data over a few days (not recommended)

3. “devicePollRate” is the period between polling of sensors for same unit in milliseconds. (1000 milliseconds = 1 second) Polling rate has to be between 900ms and 3,600,000ms. It can be adjusted based on refresh rate, data log rate # required and system load on the server.

4. When syslog is enabled, the Server software logs any errors and usage to a *system.log* file (in the same directory) which can be used for troubleshooting.

5. When alertslog is enabled, the Server software logs sensor status changes to an *alerts.log* file in tab delimited format (example record given below):

<table>
<thead>
<tr>
<th>DATE_TIME</th>
<th>LOG_LEVEL</th>
<th>ALERT_STATUS</th>
<th>ENVIROMUX_UNIT_ID</th>
<th>UNIT_IP_ADDRESS</th>
<th>UNIT_NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon Jul 31 10:08:04 EDT 2017</td>
<td>INFO</td>
<td>NORMAL</td>
<td>983168</td>
<td>192.168.3.100</td>
<td>E-16D</td>
</tr>
<tr>
<td>DIGITALOUTPUT</td>
<td>3</td>
<td>E-16D-M Door Strike 4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. When datalog is enabled, server software logs sensor data per device poll rate to ‘data.log’ in below tab delimited format (example record given). Sensor value may contain appropriate sensor unit separated by whitespace:

<table>
<thead>
<tr>
<th>DATE_TIME</th>
<th>LOG_LEVEL</th>
<th>ENVIROMUX_UNIT_ID</th>
<th>UNIT_IP_ADDRESS</th>
<th>UNIT_NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon Jul 31 10:07:59 EDT 2017</td>
<td>INFO</td>
<td>1048667</td>
<td>192.168.3.217</td>
<td>E-5D-48V</td>
</tr>
<tr>
<td>INTERNAL</td>
<td>0</td>
<td>.1.3.6.1.4.1.3699.1.10.1.3.1.1.6</td>
<td>Internal Temperature 32.8 °C</td>
<td></td>
</tr>
</tbody>
</table>

Note: For the edited *sems.conf* file to take effect, it must be edited and saved, and then the E-MNG-LC Server must be shut down (close the application) and then restarted.
Client Logs

Datalogs can be configured on Client Software by editing “sems.conf” file as below.

Please note license activation is required to enable all logging features.

```
syslogEnabled=true
syslogLevel=INFO
datalogEnabled=true
alertslogEnabled=true
```

1. “Enabled” values can be set to “true” or “false”.
2. "syslogLevel" can be set to one of 'SEVERE', 'WARNING', 'INFO', 'FINE', 'ALL'. Recommended Setting: INFO
   - SEVERE will log only system crash like messages.
   - WARNING will log severe messages and messages that user needs to look into
   - INFO will log all above messages plus some rudimentary messages like "server started"
   - FINE or ALL will log all communications and may generate several GB of data over a few days (not recommended)
3. When syslog is enabled, the Client software logs any errors and usage to a `system.log` file (in the same directory) which can be used for troubleshooting.
4. When datalog is enabled, the Client software logs only currently monitored sensor data, every 8-10 second, to “data.log” in tab delimited format (example record given below). Sensor value may contain appropriate sensor unit separated by whitespace:

<table>
<thead>
<tr>
<th>DATE_TIME</th>
<th>LOG_LEVEL</th>
<th>ENVIROMUX_UNIT_ID</th>
<th>UNIT_IP_ADDRESS</th>
<th>UNIT_NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon Jul 31 10:08:06 EDT 2017</td>
<td>INFO</td>
<td>983168</td>
<td>192.168.3.100</td>
<td>ENVIROMUX-16D Unit 1</td>
</tr>
<tr>
<td>E-16D-M Temperature 1</td>
<td>83.1 °F</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: For the edited sems.conf file to take effect, it must be edited and saved, and then the E-MNG-LC Client must be shut down (close the application) and then restarted.

Additional configuration options that apply to the Server and Client software (requires version 3.1) include:

```
datalogRollPeriod=
alertslogRollPeriod=
syslogRollPeriod=
```

1. These can be set to one of ‘HOUR’, ‘DAY’, ‘WEEK’, ‘MONTH’ which rolls the log every such period.
   - Except for HOUR, the rest of the options trigger log roll at midnight local time.
   - End Of WEEK is considered Saturday at midnight

Log Roll support provides the ability to save data accumulated for set periods of time. Once the period of time has expired, the Server and/or Client (as configured) will save the data into a numbered archive file. The newest archive will be numbered “1” (i.e. `data_archive1.log`, or `alert_archive1.log`). When the period expires again, archive “1” will be renamed archive “2” and the newest archive will again be archive “1”. Archives will continue to be added to depending upon how many have been configured to be kept (see value for “numSyslogsToKeep”, “numDatalogsToKeep” or “numAlertslogsToKeep”).
numSyslogsToKeep =

numDatalogsToKeep =

numAlertslogsToKeep =

2. These can be set to any integer value between 1 and 5000. This will keep as many archives as configured and purge logs older than this.

Note: After installing Server and Client software version 3.1 (or later), the sems.conf file will not automatically update with the new options. To use the new configuration options, either

A. Delete and Edit

1. Close the Server software and Client software.

2. Delete the sems.conf file from the Server software directory (same directory emicromanagersrvr.jar file is in) and Client software directory (same directory emicromanager.jar file is in).

3. Restart the Server and Client software. The updated sems.conf file will be generated and ready to edit.

4. Edit the sems.conf file with the values desired and save it.

5. Close the Server software and Client software.

6. Restart the Server and Client software. The values entered will now take effect.
B. Edit Only (saving the values you already have in place without having to re-enter them)

1. Open the `sems.conf` file (will need to be done for the Server, and again for the Client)

2. Add the options below to the `sems.conf` file manually. (It would be easiest to copy from this document and paste them in.)

   ```
   datalogRollPeriod=
   alertslogRollPeriod=
   syslogRollPeriod=
   numSyslogsToKeep=
   numDatalogsToKeep=
   numAlertslogstoKeep=
   ```

3. Enter the desired values for the options using the instruction on pages 33 and 34.

4. Save the completed `sems.conf` file.

5. Close the Server/Client software.

6. Restart the Server/Client software. The options and values entered will now take effect.

**Note:** The syntax of the values entered is important for configuration to be successful (`sems.conf` file content sample below):

**The order the configuration options are listed in does not matter.**

```
syslogEnabled=true
syslogLevel=ALL
syslogRollPeriod=DAY
numSyslogsToKeep=7
datalogEnabled=true
datalogRollPeriod=DAY
numDatalogsToKeep=7
alertslogEnabled=true
alertslogRollPeriod=DAY
numAlertslogsToKeep=7
devicePollRate=5000
```
SOFTWARE UPDATE

When newer versions of the E-MNG-LC become available, you may desire to update your client and/or server software. You will be notified by email that new versions are available, what changes were made to the software, and how to obtain updated software.

To perform an update, simply unzip the new client (mng-lc-clnt-vx-x.zip) or server (mng-lc-srvr-vx-x.zip) software files into the same directory the present client or server files were installed to (see “Installation” on page 4). Do not delete any files. None of your data, license, or configuration files will be affected. Once the new files have been unzipped, simply open the client or server as normal (pages 31 and 13). No additional changes or configuration are necessary.

SETUP E-MNG-LC TO RUN AT STARTUP

You may want to have the server that runs the E-MNG-LC server application to run the application automatically each time the server that hosts it powers ON. The instruction below should assist you in setting this up.

1. Create a batch file: EmicroManagerSrvr.bat containing the following 2 lines:

   @ECHO OFF
   START "EMICRO" /D"<PATH TO EMICRO MANAGER SERVER>" "<PATH TO JAVA>" -jar EmicroManagerSrvr.jar root nti

2. Replace the 2 paths:

   PATH TO EMICRO MANAGER SERVER = the path to the directory containing EmicroManagerSrvr.jar (e.g. C:\Test Files\Server)
   PATH TO JAVA = the path to the Java Runtime executable (e.g. C:\Program Files\Java\jre7\bin\java)

3. Replace the root password “nti” with the one you are using.

   EXAMPLE: START "EMICRO" /D"\Test Files\Server" "\Program Files (x86)\Java\jre7\bin\java" -jar EmicroManagerSrvr.jar root 123

4. Depending on your operating system version, follow the instructions provided by the links to open the Group Policy Editor and add “EmicroManagerSrvr.bat” as a startup script. For Windows 2003, also enable the policy “Run startup scripts asynchronously”.

   For Windows 2008

   For Windows 2003
RESTORE ROOT PASSWORD TO DEFAULT

You can restore the default root password without losing the server configuration by performing the following:

**Note:** You will need the E-MNG-LC License Key to perform this operation.

1. Shut down the E-MNG-LC server program.
2. Browse to the folder containing the E-MNG-LC server program.
3. Delete the file "serverLib.dll"
4. Re-start the E-MNG-LC server program. You should see the "License Terms" window.
5. Accept the license terms. You should see a "License Error" window.
6. Select "Install Permanent License"
7. Enter in your License Key, then select "Activate".
8. You should get a "License Activated" message; Select "OK" You should then get the root login prompt.
9. Enter in "nti" and select "Login".

INDEX

add ENVIROMUX-MNG-LC users, 10
add UNITS to monitor, 8
command line, 7, 12
configure sensors, 25
Device Discovery Tool, 9
edit ENVIROMUX-MNG-LC users, 10
installation, 4
Java Runtime Environment, 9
licensing, 4
Log files, 32
login at client, 13
Machine ID, 5
open project, 17
permanent license, 6
project management, 14
reload lost connection, 11
respond to alerts, 29
sensor summary, 20
server management, 7, 8, 31
temporary license, 5
UNIT loses connection, 11
UNIT Management, 20
using a client, 13